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HOTKEY COMBINATION

HOTKEY COMBINATION

Shift + add row
(the button of the program)

Shift + Delete

Shift + W
Shift +S
Shift + A
Shift + D

Ctrl + Del

Shift + Ctrl + C

Ctrl+V
Ctrl+H

Shift + Ctrl + H
Delete

F

F8

FQ

F10

F11

F12

Ctrl+Alt+S

RESULT

To add 10 rows of tiles

Clear plane. One selected tile will be
removed along with the rest content
of the selected surface.

Insert row above

Insert row below

Insert row to the left

Insert row to the Right

Delete row
(the row including the selected tile)

Copy tiling
(from the plane, where the tile is selected)

Paste (e. g. copied tiling)

Hide selected object

Show hidden object

Remove selected object

Finish (e. g. after creating an outline)
Top/bottom view (view to floor/ceiling)
Right view (view to the right wall)
Front view

Back view

Left view

Enable snap to objects



CREATING OF A RECTANGULAR ROOM 4,

RECTANGULAR ROOM B8 Ceramic 30
— Fle Edit View TieArea C
Click on the “blank sheet” button to create a new project. [~ CERAMIC 3D < aFElAa &
Select the option “Rectangular room”. = Crefe room (Ctile i
P 9 Views » i a Eﬂ S
Next opened window - “Building parameters™: QM x @
Building Parameters Input fields “Length”, “Width” are the dimensions of the room. Input field
Mame “Height” is the distance from floor to ceiling. All the dimensions are set in
Room millimeters. “Object parameters™ - here you can select colors of surfaces
Length \Width Height and width of joints between tiles.
f2500 f2000 [2700
biect Parameters Color of surfaces
, ~ | Joint, mm You can select any color for walls, floor and ceiling.
=t ) el b =] The background color for walls and floor is also a color of plaster or grout
. Joint, mm (e.g. in case of putting porcelain stoneware layout to the floor).
] |L e "B |z E| To change the color of the surface, make the left click on *+” near the
. 7o) desired surface: after pressing “+" the “Materials” library will appear.
113 Dark G | -| . .
= |_. AeEt 2 Select a color that you want in the section «Plasters».
ok | _Conce | Joint width

Joint, mm - is the size of the joint between tiles, it's set in millimeters. By
default the width is: O - for ceiling, 1.5 - for walls, and 2 - for floor.

Irregular room e L et G S,
Press on the “blank sheet” button to create a new project.
In the appeared window click on “Specify room outline”.
Prior to building the room, make sure to activate

the snaps.

Snaps allow you to draw the outline of the room with

the

mouse, defining one point or another.

You can draw the outline by such instruments as:

I Line | I Spline | e Line * Spline * Rectangle
| Rectange | I Elipse | * Arc * Ellipse
e e | R

— By using Arc, you can create a curved wall. Three points build
G+ ) - o O X 1 the arc: two side points and the point in middle of the circle.




CREATING OF A RECTANGULAR ROOM o

Spline creates a complex curve. The number of the clicks that coincides with the number of bends you
require creates a curve.

Ellipse creates columns or round rooms. Three points build it. With the first click, you create the beginning
of a circle, with the second one - you set the radius of the first direction, and with the third one - you set
the perpendicular radius.

Rectangle is built by two points.

Line

Line is the main instrument used in building rooms.

Enable the instrument “Line™:

Make the left click on the working surface.

Then set the direction by the mouse, type the value of the distance and press Enter.

To continue drawing from this point, set the direction again, set the distance, press Enter. Repeat until the
outline is ready. When the last line is left to be made, press on the “Close” button.The outline of the room is
specified. To finish click on the “Finish” button.

In “Building parameters”, you can set:

Depth defines the distance from floor to ceiling in millimeters.

Object parameters section is for choosing colors of surfaces.

The room is ready.

To move the camera go to “Views” section.

By default, there are six viewpoints. Click on the middle icon to switch between floor and ceiling.
Using the perspective camera style can be helpful.

Press and hold right mouse button and move the mouse to look over the room.

Views Catalogue of tiles
Q g 1\.\ Prior to work, preapare the catalogue.
; You can download new collections:
@ ’ﬁ Iﬂ 1.Go to the tab “Help” - “Download collections”
a ﬂ 2.Choose the desired collection
3.Click on “Download and install”

" 4 When downloading is complete, go to “Show Catalogue”
P& 5 = o "
S and press “Reindex” (Refresh)
Show Catalogue
Gl T . . ion [ - o x
Tiles catalogue: Download\India\Nitco\Kratos\ G
_—JDSpan 18606,53 Mb ~
[ @ [JacCeramica  35,%0Mb
' o‘ n ‘ ‘ EDA.C‘A.Cevamcas 1,02Mb
5] [] Absohst Keramika 523,25 Mb
V. ¥. “4 |)GE A 8 Qsints
@[] Alaplana Ceramica  26,12Mb
@[] Akalagres Porcelanico Integral 201,96 Mb
Search by Name | Q 5 Dl Aera Caromca. 32,631
B [JAittoGlass 58,04 Mb
@[] Amadis Fine Ties  5,43Mb
4 Tiles A B[] Aparic Ceramica Porcelanico 677,30 Mb
B [JApavisa  180,91Mb
TILES DAMX‘B 3,35Mb
- ] Anarchy 14,49 M
p _TILES1 gmyﬁ-mm
- Burington 4,70
[JCastiron 4,19Mb
4 Download Clevoktion  6,37Mb
dl [JFantasy 1,06 Mb
A Indi [rberglass  2,15Mb
I @ OForma  3,03Mb
3 [QHydrauic  0,55Mb
4 NItCO Clconic  7,32Mb
Belglum Oinox  2,17Mb
Crido  1,39Mb
[lava &,08Mb
Casa [uifestone  4,89Mb

[JLimestone  1,93Mb

[IMarble  10,91Mb

[COMateria 20,48 Mb

[Ivetal  4,85M0

[OMicrocement 4,26 Mb v

Download and install




CREATING OF A RECTANGULAR ROOM

+ COLLECTIONS | MAKE A PAYMENT |
About Us Reviews contacts Tutorials @

Name

=

=
@
2

E-mail

o)

Telephone

O\

"

Name of collection or object

Comment

o U

No files selected

‘Additional files

If you cannot find the collection you need, send the request
at ceramic3d.com

Uploading tiles individually

If you add tiles by your own, try to get images of tiles at a
producer’s website.

Find the desired tiles' images in the Internet.

You can save images in any of commonly used formats (.jpeg,
Jjpg. -png, .tif, .bmp). Click with the right mouse button on the
image, press “Save image as”.

Save the image to whatever folder is convenient for you
Open the catalogue of tiles and find the button “Import™.
Select the image in the folder where you saved it, set
parameters for the tile (item code, name, width, height).
Press OK. The tile is imported.



TILING

Tiles catalogue: Download\Spain'Equipe CeramicashAlpstonel

Select the tiles for the layout.

v 4 OMe @ A [swembeesn  Thereisa tiling buffer n the rightmost part of Ceramic 3D

Search by Name Q Y E: L 4 @ + InterfaCe
al

| 4 Ties

4 Download
b India
b Russia
4 Spain
4 Fauipe Ceramicas catalogue.
Alpstone
Areals

Arrow

- The catalogue contains downloaded tiles
- Add the tiles you need for the project to the tiling buffer
Click on the “Catalogue”. Find the downloaded tiles in the

-
o Click on the button i& “Use all of shown objects™:
:23:”0 After that, you can close the catalogue window and start the layout.
Caprice You can also select few tiles:
e 1. Press and hold Ctrl and click on the desired tiles with
CavENT i e the left mouse button.
Chevron 100 x 100

2. Pres on the button *Use selected objects™

The chosen tiles will appear in the buffer in the ﬁ ‘a

right side of the screen.

Start with paving the floor.

Use left mouse button select the tile in the buffer - you will see the
image of the tile in the left toolbar. Click on Add row to add one line of
tiles.

Press and hold digit 2 - there will be added two lines.

By using the combination Shift + Add Row,

you can add 10 lines at once.

To set the beginning of tiling use the Alignment.

To make the layout at a certain angle, select any tile on the plane by
click rouwenge[s ¢ the left mouse button then in the Row Angle option
set the required angle, (e. g. 45 degrees) and press Enter.

To complete the empty space on the plane, make the left click on any part

of the surface. The diagonal layout is ready.

Creating offset.

Offset can be set in both percentage and millimeters. To create a brick layout
pattern, set the value “50%" and press the tick.

Pave the walls.

Select the required tiles in the tiling buffer. There areicons ® #* &

of arrows around the image of the tile, which you can use >
to change the orientation of tiles before making the layout.
The orientation can be horizontal, vertical or diagonal. ol

After putting the tiles on the plane, you can replace those using options
Replace and Substitutio zedece subsstuson You can replace one tile at a time
or full rows by selecting them with left mouse button. Mind that replaced and
replacing tiles should be of the same size and shape.

Shift + Replace can replace the whole layout of the tiles.
This option allows you to edit the project quickly in the customer's presence.

If you need to put tiles of different size, use the option Insert row. You can
insert above, below, to the left or to the right from the selected tile. Select the
tile, make right click on it, go to Insert row and click on the option that you
need.

T - P
 AETRN RN
* B
® 3 &
E <V A>
e,

Offset lEﬂ '|r(i::n

\
4 Cut CtrleX |
Copy Ctrl+C
Copy Tiling Shifts Ctrl+ C

Hide Selected Ctrl+H

Edit Borders

Select Plane

Select All Planes

Select Apertures and Insets
Select Always Hidden Objects
Recover Angle

Ungroup Pattern

Tiles Move

3
3

Insert Tile o Insert Row Below Shift+5
, Insert Row Left Shift+A

Removal of finishing materials  * St ot
— Insert Row Right Shift+D

Edit Material Copy Insert Row "Plus"

Edit Matenial Insert Row "Minus"

Change grout...

Properties

Tile Properties

Box Properties
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Removal of finishing materials  * Delete Tile

T Delete Row Ctrl+ Del Rows can be both inserted and deleted.
ateral Lopy E i .
Edit Material gle'e‘feT_T"":'“*“g To remove tiles from the surface completely,
€ar e Area . . .
e s click the right mou's? bl.itton on a.ny tile,
Prnipertie Clear Plane Shift+Del go to Removal of finishing materials > Clear plane.
Tile Properties Clearwallpapers  Shift+Ctrl+ Del
When you complete the layout on one plane, you can copy it to % cu CtrleX
every other one. Copy Ctri+C
W CopyTi ShiftsCtrl+ C

+ Select the tile on the plane and
« Press right mouse button and click on Copy tiling otion Select Plane
+ Select the tile again, press right mouse button and click on
the Select all planes option
+ Make right click again and press Paste
The layout appears on every wall.

Select All Planes

Select Apertures and Insets

The layout appears on every wall.

Clear one plane and coincide vertically orientated tiles with 53 ‘ |
horizontally oriented ones. Blue arrows below the image of

the tile in the left toolbar set the direction of the layout.

Every arrow stands for a certain direction of the layout: ‘ % ? g Zg’ @

* Bottom-upwards

* Top-downwards ‘ ' ‘

*  From left to right

*  From right to left ilv A )

Make the horizontal orientation of the tile, select the direction from left to right, and set the alignment from
the left bottom corner. Add two rows, turn the tile to the vertical orientation and add some other rows.

This is the way to coincide differently
orientated layouts on the same plane.
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Pattern is an option of the layout. Patterns >

To make the work convenient, there is a pattern editor in the program.

You can find the panel of the editor in the right side of the screen, the panel can E:I
. . . woon A

be shown or hidden by pressing the icon “»".

Patterns are easy to use: all you need to do is to select the tile, then drag it with
left mouse button and drop in the empty part of the pattern. You can rotate tiles
inside the pattern with the right mouse button. When the pattern is complete, __is
press on “«” to use the pattern and move it to the tiling buffer. > Sl

.
A
||

B
Use pattern

walpawsl Patte You can create your own pattern.
= ; To go into the creator of patterns select the tile in the Tiling
— s | p— 1
Y &t me | m buffer,

= press right mouse button and go to “Create tiling template...”.

To work with several tiles, hold Shift to select the required ones.

Create tiling template... To copy tiles:

Create Pat...
s *  Select the tile needed
Nabe.,qsseoﬂz zunt:Tc al ° Press and hold Ctrl
L n Til
iy i *  Without releasing Ctrl hold LMB and drag a new

Update Image R
copy from the tile

Properties

To rotate tiles:

*  Select the tile

*  Press and hold Shift

* Make a SINGLE left mouse click on the tile - the red cross
appears

*  Without releasing Shift make the left click once again and
without releasing left mouse button either, rotate the tile

Hook the corner of the tile to coincide it with the other one

precisely.

After the pattern is ready, make the right click on the

pattern, press Specify cell offset (the way the pattern
is placed horizontally), then make the right click again,

press Specify row offset (the way the pattern is v M.m
placed vertically). The last thing to do is to save the s
file. There is no need to select the folder, by default
the pattern is saved in the folder with the selected

tiles.

Snap to Active Points
Snap to Edge Extending

Cancel offset task
Save File...
Add to stacking buffer




INSTALLING OBJECTS

i kil D Copy e
= Fida Selected e
e

< Move M
€3 Rotate. ]
B Seale H
Graupmg
Editing
X, Delete el
Edit Matenal Copy

You can find the catalogue of objects in the top toolbar. > =

There is a wide range of 3D-models. Category and manufacturer divide
them. Let us install a door. Click to the desired wall with left mouse
button, find the door in the catalogue and install it to the wall with the
double left click.

You can edit parameters of any object found in the catalogue. To do
that, press to Properties in the context menu.

Here you can change size (width, height, depth) and materials of the
object.

[ [Group from C:Ceramc 0\b ObjectsV 1111\pricke 72 FFF
Poston o vp zh W Rely
Apachte positon [0 wfi7  z{24 [ Res
Argies 20 wp R0 I Rely

hom v

Aways heden r

utomatic shgrment Enable

Conect tyoe. d Chocse .. Clear out
Affects the evvronment |~

W:| 1008 \l
wEE | Rea

There are two ways of moving objects in the program.

Firstly, you can do it with arrows on the keyboard.
Secondly, you can move objects to the precise distance.

Click ontheicon “* with the right mouse button.

0~ 3 Here you can set the precise distance from to all the planes.

Q) e[ 2] The door is installed!
Install sanitary ware (bathtub, washbasin, decorative objects and
the mirror).

4 Objects
b Curtains
b Decor
b Doors
4 Download
4 _Factories,
4 Italy
b Armadi Art
4 Baronceli
Edit
4 Bocchi
Aba
SR
Etna
b Light
Equipment
P Furniture

B8 Objects catalogue: DownIoad\_Factnrics_\ltaby\an:chi\Ares\ - [m] X Relative Move n
w.r. 4 8 < ! [} Soutce: only selected fokder

SeachbyNeme [ Q |'Y HI » m e Selectionbyname [ [ I B

ffse

Ares 100 ares 60

] Cancel |

ares 80
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B8 List of object collections — O it

S e i Downloading objects. from Ceramic 3D server
@ Clcurtsins 34,38 Mb As the catalogue of tiles, the catalogue of object is
H-[JDecor 238,83 Mb £ L d d

@-[Doors 280,74 Mb requently updated.

- [] Equipment 2,17 Mb To download new collections, go to

- [] Furniture  1352,56 Mb .

@ [Jkitchen 172,27 Mb Help > Download objects.

E-[JLightng ~ 79,35Mb

E-[JwC  2030,53Mb . . .

@[] Windows 26,53 Mb You can find downloaded objects in the folder

IS} M} Factories_  2410,35Mb

P T Download in the catalogue of objects.
#-[JBulgaria  0,35Mb
#-[JCzech 69,59 Mb
- [JEstonia  2,05Mb
E-[JFinland  20,34Mb Help
E-[JFrance 10,00 Mb
- [JGermany 896,79 Mb H Elp
B[] Great Britain 5,69 Mb i -
@-Clitaly 470,27 Mb Restart Application
B [JPoland 256,42 Mb
E-[JPortugal  5,01Mb Restart Render
EeClhemn - 0 E. License Agreement
B[] Slovenia 86,23 Mb
m-[Ispan  63,53Mb Update Key Data...
E-[JSweden  1,37Mb 5
[]--DSwiizerIand 51,02 Mb |l"‘|f0l'matl0n Wil'ldow
B[] Turkey 38,65 Mb
eL|theme St Check for Updates
E-[Jusa  46,54Mb p
Download Collections
T = Download objects
Download and install About... I
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Objects Window Help

- e - The instrument “Box” builds any installation in the room.
Hide Selecte rl+ * -
ShcuwAllct ghrﬂ:-‘-grLﬁ ﬁ @ @ E i "3D' 8 H y
e g Create a box for the hanging toilet bowl.
Edit Influence Select the plane of the wall, where to place it.
7l Catalogue of objects
Marard oot Go to the tab Objects > Box >Rectangular
Panorama 360
- : In Object Parameters window, specify size and materials

for the box. Set the width as 1400, height - 1200, depth - 200.
Custom As any other object, box always goes to the center of the
previously selected plane.

Niche
Aperture

Border From Tiles
Light
Create by outline

Tiling Direction

By Dimensions
Edit Shape

Pairing points

e Now you can make the layout.

Use elliptical box to create a column. Select the tile on the floor.
Go to Objects > Box > Elliptical. In the appeared window specify
size of the box: width, height and depth. In this case, depth
stands for the height from floor to ceiling. The column is ready.

Building Parameters ;:::S::dﬂ:hﬂézg:: G] ﬁ q} Q
i Saveto File » :
|Box Edit Influence
Width Height Depth Catalogue of objects
|1400 |1200 200 Mansard Roof
i Panorama 360
’ g Inset P
[~Object Parameters Miror »
Jont, mm | Rectangular
B o s || e
Joint, rrm Aperture ¥ Custom
r Ik 01 White + m Border > From Tiles
Light * By Dimensions
01 White - Create by outline W -
Iﬁ o L :] Tiling Direction j | ReEdR Share
Pairing points 4
| 3D tiles 4
Make the mosaic layout. Because the surface of the column is curve, it is
|center mm)  ~|o mm v necessary to divide the surface by segments. Go to “Surface division” menu
in the left toolbar. Select the option “Center (mm)” and specify the width of
HideSelected  CirkeH | (] 28 o o) one segment in millimeters.
Show All  Shift+Ctrl+H -
Save to File 3
Edit Influence .
e e After that, press the tick. To make the layout to all segments at once, make

Mansard Roof
Panorama 360

the right click to the column, go to “Select all planes” and then Add row.

Inset 1>
Mirror »

Create a podium for shower cabin. Select the floor surface.
Go to Object > Box > Custom.

Rectangular
Niche 4
Aperture 4
Border ’
Light 3
Create by outline r
Tiling Direction 1
Pairing points b
30 tiles r

Elliptical

From Tiles

By Dimensions

The shape of the box can be a curve. Start with the instrument Line. Set the
necessary size for lines. Use Arc to complete the outline.

Press “Finish™.

Specify the depth of the box. In this case, it stands for the height of the
podium. Move the ready box to the precise coordinates if needed.

Edit Shape
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. . . Hide Selected  Ctrl+H A .
Next type of boxes is a box by dimensions. We use el B O Building Parameters
it to create a screen for regular rectangular ::;‘I:;I:::“ ; Name
bathtub. Install the bathtub. Select the bathtub, Catalogue of objects =
. o o Mansard Roof Object Parameters
gor to Objects > Box > By dimensions. Panorama 360
Make sure that the option Create top face is pe 2
irror -
deselected. Rectanguar
Niche 4 Elliptical
Aperture r Custom
o . . Berder From Ti
Select the joint width and press OK. B T
e Dy "1 it Shape
Tiling Direction 4 - -
Pairi ints 4 RS
e AN o | _cacel |

You can put tiles on that box.

The program does not count tiles behind the box.

We can see how objects influence on the layout

in the instrument of Edit influence.

Go to the tab Objects > Edit Influence,

here in the left panel, you can find all the installed
objects.

There are four types of influence.

No Influence - tiles behind (under) boxes are taken into

account.
Dimensions, Section, Filling mean that the tiles behind the
= - Swe | == box are excluded
Hide Selected Ctrl+H ptions
A St e el from the calculation. If needed, you can change the way
- — the influence works,
A Catal f object v Eilli . . .
S o o & Filing for example, include the tiles behind the bathtub to the
Panorama 360 B Box .
) calculation.
Ins: [ - Rectangle 1. . . o ”
el : oot Select the option “No influence” and save.
Box 13
Niche »
Aperture »
Border L
bahte ... ' Create a niche.
Create by outline ’
Tiling Direction >
Pairi int: » . . .
i , Select the tile on the wall, go to Object > Niche >
Rectangular.
R Specify the size and joint width, press OK.
ide Selecte tri+ = . .
e @ s C'IvB = You can move niches as any other object.

Save to File v Right click to the instrument “Move™.

Edit Influsnce Put some tiles on the niche.

Catalogue of objects You can change size of any box or niche.
Mansard Roof Go to the context menu (right mouse button),
BRI then - Box properties and change the size.
Inset ’ It will not affect the layout.

Mirrar L4

Box L4

Aperture L4 Elliptical

Border L4 Custom

Light 4 From Tiles

Create by outline 4 By Dimensions
R ;

T|Ifn‘g Dlre-chon Edit Shape

Pairing points LS

3D tiles L4




CALCULATION AND SPECIFICATION FOR TILERS 14

The project is ready, make the calculation of tiles.

Make the left click on the “Calculator” icon in the top toolbar. In the appeared window press on the
“calculator” again. The tiles are calculated. To make the calculation precise, you need to set the Halves
account, depending on the type of tiles you use in the project.

In box_ Total Prce
Tile View em Code o e Halves account Margin o an G Pt e i Discount Total price
010213001169 Metal
et daik satin border [} 0.00 ot sented satng o 0.00% 12 041 0 000 .00 0.00 0.00% 0.00
01
X
010401002331 Invemo _
DR ] 0.00 it senned g 0.00% 12 13 0 0.0 0.0 000 0.00% 0.00
010402001277 Inverno -
0T ] 000 ot orimied excoding o 0.00% 62 116 0 000 000 000 0,00% 0,00
010402001278 Inverme ot s g 2]
sk [} 0.00 ot orented exciing fa 0.00% 5 108 0 0.00 0.00 0.00 0.00% 0.00
010101004955 Ottavia 'ﬁ
I beige dark wall 02 0 0,00 Mot onented exduding fa 0,00% 50 13,50 0 0,00 0,00 0.00 0.00% 0.00
Total 0.00
Color Hame Wargn Cuanliy Amauniin package Packags price Packages Total prce
L Grout Jasmine) 0.00% 2374 0.00 kg 0.00 0 0.00
« Grout (White) 0.00% 024kg 000 kg 000 0 0.00
° Grout (Anthracite) 0,00% 0,10 kg 0,00 kg 0,00 0 0,00
f’ Adhesie 0.00% 13051 kg 0.00 kg 000 0 0.00
55 Primer 0.00% 10441 0001 000 0 0,00
s
Cross spacers 0.00% 520,00 pos 0,00 pes 000 0 0.00
Total 0,00
The discount  0.00%  Discounton % Total amourt: 0,00

wallpapers

Oriented - every tile (including cut-offs) is counted as the whole one. This type can be used for tiles with
asymmetrical image.

Not oriented including factory edge - every tile is used twice (only the side cut-offs, the middle cut-off is
not used). This is the most popular way of halves account.

Not oriented excluding factory edge - every tile is used more than twice, every cut-off is taken into
account. Normally used for porcelain stoneware with cut-off edges.

By area - is used for mosaic.

You can also specify the margin in this table. If you have diagonal layout, offsets or pattern layout - we
recommend set the margin to the value of 10-15%.

Tiles are calculated in pieces and square meters. If you sell tiles by boxes, fill the column In box (pieces or
sq. m.)

If you want to show the price for the customer - fill the column Price.

The program also counts supporting materials.

To make sure the calculation is correct, click on the arrow sign near the calculator, and go to Calculation
Check. Here we can select a tile and see all the parts taken into account. To close this mode, press Esc.
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Pres to the printer-looking icon in the top toolbar.

It is the instrument Print. Make the left click to the button Report.

To start with, choose the orientation of the paper (left bottom corner).
The menu can be divided by two parts: left side - sections of the report

(you can include or exclude them), right side - settings for every section.

Printi
Report

(]
OEEfFY eton Phaser 3260 =] e Pt Reoart
Gase paint Havigation
O00 g
]
e a
Tools s
Frame Picture o Room Bcormnt . Room blueprint -
:: sz::ws Scale 1: [55
] 5
e  Welvhn . Font size of te -
Radus Grde Miimal tie number font sze [4,5
Caladation are " Table of tike cakculation . Area of cbject detection [1500 e
Box ivolation Scheme: % Show objects
Table of supplies objects pastion
= = Choose letterhead... L
I~ Show bawes positon
30 top view I~ Show insets
® Choose letrerhead...
Corsider a3 eque i sze difference < 0,1 -
3D general becsopacty 0
L e Choose letterhead... i b
R show tie mages
I~ Show tie numbers
el
Clear Letterheads  Choose Letterhead
priter
[erax Phaser 3260 =] | P show letter designations for wals .
[as - Save settings Load settngs
& LA .
L xps ¥ A Paper arentation SetMargie... By defadt Concel o
Lz ofp Ao A
I~ Line weight Update Al

B

w8 e L - L -~ - - -

=

- —=] to save the report as images.
T o el e i i o s Ll
— ;| = -
R - 700 [ an ren =
Y e e e N
2 P a

Tren - o

Gracia Ceramica 3 [ iwermowhite PG 01 62pcs  Ottavia
Code: 010402001277
< L] Oltavia beige dark wall 02 50 pes.

Invemo Bl 603 300 Code: 10121004555
. e s cnbent 01 12g05 o sniPG @ Spes il

Code: 010212001168 Code: 010402001278

Stze: 750% 12 Size: 600 x 300

CERAMIC 3D ™

Porat

Landscape

The settings can be saved for future projects. Go
to Save settings. Settings can be saved in any
folder or in the registry (in this case, you will have
no need no find the folder every time).

You can instantly print the report or save it in .JPG.
In any case, go to Print, check the box Print to file
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To create a letterhead with your logo, go to Print.
Select the landscape orientation.

Portrait Landscape

Start with the instrument Frame in the left toolbar.

By this, you can determine the area for the sections of
the report to be shown. Logo and other information will
be below it. Create the frame with left mouse button.

Select the frame, press right mouse button, go to
Properties, check the box Free area.

Continue with creating the logo.
Go to the instrument Image.

Select the picture, make the left click to the area where
to place it. Specify the size of the image with LMB.

Type all the necessary information (address, website,
phone number etc.) with the instrument Text.

Activator
adv
Archive

Banners

Tools

Frame

Text

1 objects

Allowed sections

=

Room blueprint
Wall plan

Table of tile calculation
Table of supplies

3D top view

3D general view

View from the panoram

Estimate of objects

MNote
Auto-Spotting

e

OK

Cancel

CERAMIC 3D ™

Create the folder Blacks in the directory.
Save the letterhead to this folder.

Make sure, that the name of the letterhead
follows the example &]A4 ceramic 3d

(there should always be A4 before the name itself).

Bglmages
Blanks
CEF

Save. [g]¢

The letterhead is ready to use.
Click to Choose letterhead in the report menu.

Select the desired one with double left click.

Collections &rchives

Box outline color -
[Z Chau simn af dinnad & "
Choose Letterhead... | | etterheads n
A4 ALPHA TILES £

—
E—

Set Margins. ..

A4 Ceramic 3D
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Insets are used to create several areas on one plane or to
combine tiles of different shape. As examples, there are kitchen
aprons, floor and wall panels.

Highlight the shower area with mosaic. Use the rectangular inset.

Objects > Inset > Rectangular. Set width and height and press OK.

The new area appears on the wall. Insets can be moved as any
other object. Tiles behind are automatically excluded from the
calculation.

Some collections of tiles can contain Elliptical insets. For example
- Russia > Kerama Marazzi > Belgravia.

Use Inset > Elliptical to work with such tiles. Specify the

dimensions (the same as the tile has in the catalogue) to create
the inset. You can move the inset to the necessary position.

You can Copy inset and place it on the wall several times.

Inset > Custom can be used to create kitchen aprons. Create
the outline on the wall, choose the grout, and make the layout.

Objects  Window Help

Hide Selected Ctrl+H
Show Al Shift+Ctrl+H
Save to File 4
Edit Influence
Catalogue of objects
Mansard Roof

Panorama 360

Fee=H

Rectangular

Mirror

Box

Niche

Aperture

Border

Light

Create by outline
Tiling Direction
Pairing points
3D tiles

r*r ¥ rFr v v r r v rr

Elliptical

Custom

From Tiles

Empty from Tile

From Tile Areas
Empty from Tile Areas
Panel Censtructor
From pattern

Edit Path

Building Parameters

Mame

IInset

width Height

1000 2470

ject Parameters:

Joint, mm
‘ White il 5 [+

oK Cancel |

QBADOS
Belgravia beige
[ apphy (120 x 160)
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Use Inset > Empty from tiles to insert panels to planes. This type of inset basically removes tiles from the
surface, so you only need to add the ready-made panel.

B Untitled - =] x
Fie Edt View Tiefrea Objects Window Help Ready
(] CERAMICSD S popm g tesos v |J @ o aBe5 (83 ms + Q&AM XIF IVF 2 HA Xeee-m ~ 5Lk o0 | &
[E] Save 1o File. v
ng - [ Edit Influence bl |w*°°‘“\ o »
A (] Catalogue of objects = -
N _= Mansard Roof Y it me 2
Qo Panorama 360 - .
aw Inset 0 Rectanguise
Mirror v Eiptial
o= Box v Cusom
HEBE Addrow Niche ’
Apsrture ,
WOE - e : : ]
O Light v Emptyfrom Tile & [~ ]
- .0 Shuffie :?emnyounine » Pan?(;::‘wlc:orrm I-
Tiing Direction »| From pattem 03 sty 8 2 25
Paitng point: Y e
o oo e
Row angl [0 )
ot | o
I—
20
=]

aitorn lappated (600%1195)

Baitorn lappated (600%1195)

Boftora appoted (600%1195)

Baitora lappated (600x1195)
& 1pes

Thng area

Any inset can be outlined can be framed with the
border. Select the border in the tiling buffer and place
it horizontally. Select the panel, go to Objects > Border
> Outside by Outline. The first four types can be put
automatically.
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Mosaic is frequently used as borders. It is possible to
place the mosaic with required number of rows.
Select the mosaic; go to Row width instrument in the p
left toolbar, pecify the width of two dices of mosaic 1
and add row. When continue to lay tiles, mind to

change the row width back, to avoid cutting all the "
tiles on the plane. The border is ready. Is

Hide Selected  Ctrl+H |j| =% q:, - @ s

Show All  Shi trl+
Save o File L Using of the mosaic border by outline (e.g. around the
Ed't 'l”ﬂ”e”cfe " window). Select the surface with the window, go to
A Objects > Border > By outline.

Mansard Roof

Panorama 360
Create the outline with the instrument Line. Draw the line

Inset 2 . Sy . .
S N clockwise so the border is outside in relation to the line.
Box 4
Niche v Press Finish. For Height set the height of the number of
Aperture 2 dices you need. Select the angle type (bisecting line or
e : Sorizor::}alg?r Dim.ensions with insertion).
ight ertical by Dimensions .

Create by outline 4 Outside by Outline The border is ready.
Tiling Directicn L4 Inside by Outline

i 3
i | Delete Border

e =t

s

You need to dice the mosaic net to see the grout between
dices. Select the mosaic go to Change tile outline.

Tiling Ways...
Change Tile Outline L)

Recover Default Qutline

Save Tiles... -
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Delete the old outline by selecting it and pressing Del.

Set value 0,5 for X and Y in the rectangular grid
alignment section.

Create one quadrate with the instrument Rectangle.
Copy it.

Create 2D-array with the instrument in the top
toolbar.

Select the dice and set the offset and the numberin
two directions.

You can change the values by rotating the mouse
wheel.

|K X 0,5 v[o,5 |E

—
Tadu
ars

Create 20 array from selected objectsi

2D array

Mumber of rows |2—
MNumber of columns IZ
Step X, mm IU—
Step Y, mm IU

oK Cancel

Finish. Press OK to create normal map.

In this case, we began from the top right corner, so
the X field should have positive value and the Y field -
negative.

Grey quadrates appeared after specifying the step are
the dices.

Set the necessary number of rows and columns,
coincide the cutting step so the texture and the
outline are coincided also.

= The outline is ready, press OK.
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o nn o s Create a mansard roof (vaulted ceiling). Go to Objects > Mansard roof. Here

Bectnstio L you can see the top view with the room height shown. Input field in the right
el e shows the distance from the wall to the line on the ceiling, where the slope

=| Save to Fil ’ .
E:T;EIH?IUL:CE meets the flat ceiling.

Catalegue of objects
T I You can see the result in the construction mode. There will be no tiles on the

Panorama 360 slope.
Vaulted ceiling can be also constructed with the instrument Box.

Inset

Mirror

Box

Miche
Aperture
Border

Light

Create by outline
Tiling Direction
Pairing points
3D tiles

Room n
Offset

1500 |1000

*¥ ¥ ¥ rF wv w v v v v w

2700

oK Cancel
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You can always change room outline during working.
Go to the instrument Change room size.

BO | (D)
- oono
T Change room sizei

You can change size of the room and add protrusions in this
editor. To change size of the wall - change the numeric value of
the distance. To add a protrusion - go to Protrusion section in
the top toolbar. To prevent walls from changing, press on the
“lock” to save the line's distance value. Press on the Delete
corner to remove the protrusion. You can also change room
height in this editor. Press Finish to confirm changes.

b 1480

File Edit view Tie Area Objects Window Help

‘\ ,‘ a ﬁ Protrusion Delete corner Delete projection Grid size X: ,'_j‘_" 10 mm IE‘ i ,'_j'_" 10mm  Room height |3000 mm = Cancel

Spread of laying ﬂ

Select the method of laying the finishing materials
ah the newly created walls:

‘
‘ ~ continue laying fram

the: adjoining walls

" crosswise laying




RENDER. BASIC SETTINGS 23

Light settings

Open the ready-made project. " — o :
Start with setting the light. There is a default light source in @ 8 a2 ‘*. () El n

every room. Advanced lighting modelk
Click on the lamp icon in the top toolbar to show the light
sources.

Delete the default light source. To adjust the light in the room easily, find the light collection in the Objects
database. Place as many light sources as you need in the particular room. The approximate number of light
sources is about one light source to 5 m2 of the room.

Tile settings

Every tile type is set individually. Select the tile, press RMB, go to Tile properties. In the Material
characteristics section, specify the suitable type of material, edge and bump for the tile.

pe—— - o X If the tile is selected in the tiling buffer - the settings
: e Nane [Anmsoura the bisch edged Wil'l' be Only appl‘ied to the partiCUlar projeCt. If you
N c e G FET T roparahe it make settings in the catalogue, you will save them to

Diectory to obiect fie [Dowrioad\Ruzsia\K erama Marazz

Iter Code |DPED4700R
Urique [0

Dimensions

T Always check the materials of object. There should
N always be a material selected for every object.
Price per sam. 0,00 pus

Ecanomic paramelers
I I _:}
Clear glass .
Amount i package il Assigned materials:
+

Pnna'i Pyt
Material charactenstics
Material TR - | Polished bronze 0 Polished bronze = |55
Edge | <defauits - )

I~ Price pes sgm.
Bump [ defendt> -

I Irvert bume

Cusstornize matenal

all future projects.

Saturno II Large Pendant.

ok | Concol | Recover |
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We take photos in 3D mode, where we choose the best viewpoint.

In the top toolbar you can find settings Min, Lin, Max.

Min - color contrast, the optimized intervalis 0,3 - 0,5
Lin - light intensity, the optimized interval is 0,1 - 0,00001
Max - brightness. The optimized value as is 10

Min 0,3 Ln[0,01  Max|10 [~ Saturated Highlight [0
Take Snapshot n
rImage Size
Width (px) [1520] Full HD: 1920x1080 |
Height (px) 1080 HD: 1280%720
I Keep aspect ratio A R
the picture by pressing on “Take snapshot™.
rPrint Size
Width (px) |508 Resolution |96
Height (px) 286
folder” to check the result.
Snapshot Mame
fligiiz &
! T B
| =.1rEG | kel

* From video memaory
 From sareen

enaer
¥ Use render
¥ Update data

Take Snapshot

To get preview image - press on the Visualize current view button. ©
If the picture is Acceptable, press on Take Snapshot button ' _ ..

In this menu, you can set dimension (image size) and the size for

printing. Always check the boxes Use render and Update data. Save

The picture is saved to Snapshots folder. Go to “Open snapshots
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Creating a Panorama 360.
When the light and tile settings are made, go to 3D mode.

Select a viewpoint and press Camera to center.

Camera to Centerl

Objects > Panorama 360 Objects Window Help New Pancrama -]

1 C T Name
In the appeared window check the boxes: Hide Selected Ctrl+H Panct
Full screen - to open panoramas full screen Show All - Shift+Ctrl+H size
automatically Save to File C & FUHD [080) i (300

L " HD [720) i .
Current view - to save the viewpoint as a position of Edit Influence £ Custom LD
the camera Catalogue of objects
Panorama type

Application - file .exe, opens the panorama on any PC Mansard Roof [coicme ]

File .cp3pano - this file can only be opened by

PanoramaViewer app

Press Create. Panoramas are saved in the folder Local
disck/Ceramic 3D/Panorama.

Window Help

“ Objects...

Camera Animation  Shift+Ctrl+Alt+|

Ctrl+Alt+0

Sun Editor

Background Image

Project Statistics...

Project Properties...

Show Snap Window Ctrl+l

v
v

Tiling Buffer

Patterns

Iy
&

£5% Project options

1
5,50, 63,50 1,00 : -0.79. 0,
5,00, -60.50(1.00): 0.24. 0,

E_RTR
o — [

Add Inzert
Change Delete
Time lU
Speed l'l
Puosition lD. 992 /-0.626
- +Ang|esl-28,ﬂﬂa" 050
[[eota0 =
Plavback :peed

|1 I~ Show

Angular velocity coeff,

Druration

/1 TR

Spline Parameters———
tduiltiplier 1 I1
duiltiplier 2|1

Play
Save Load
width Height

1320 % 1080

Panocrama 360

Intereye distance [mm] |B4

[ Display in full screer

rSave
¥ Current view
¥ Script for website
v @ppiicafiort

¥ File .cp3pana

Panol

Create Cancel

Video

Go to the tab Window > Camera animation.

You will see a control panel in the right side of the screen.

Go to Settings and choose the viedo codec xVID-MPEGA4.

Then change settings in the panel:

° Speed: 5

* Playback speed: 5

Speed settings can be changed if you need to slow down

or accelerate the video.

Choose the resolution of the frame.

The process of creating the movement is simple: you create points and
camera follows from one to another automatically. To create a point press
Add, move the camera to another position and press Add again. Repeat this
action to create the camera way that you need. Try to stay within the room.
Press Playback to see the preview play of the video. Every point can be
deleted or changed. To create a visualized (rendered) video, check Use
render box. Time of creation of rendered video depends on the graphic card
capacity and complexity of the project. Normally, it can take up from 1
hour.
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There are also settings for the sunlight in the program. You can enable or
disable the sunlight by clicking with left mouse button to the icon in the top

toolbar.

Material Editor

Emission
Emission
Scene

Emission level 15

|Lighting PBR

Outer radius [1 4

Emissionlevel [10

Radius [05

¢ f

Lightpower [30
Spot umbra [20
Attenuation [0 98

lghtpower 10

Attenuation 0,98

opacity i
mﬁnﬂl'o_
speculse [T
specularior[[5

/|
J‘J

[
Il

Il
1]

Ughteolor| o]/

Lght color =¥

lighteoot| <] F
Spollight pesumbra [50

bsefis

specular color =] Va

‘emission color | ~| 7

o —

roughness [0.2

vasmitonce [T wemsmtacecder| o] £

thin film thickness [0

thin filmior [15

You can edit the position and the

& B " i *

Enable/Disable sun light in renderi

s @ .
Edit Material |
Edit Position
Emission level stands for the intensity of the light. The
default value is 30, you can decrease it down to 5-15 to
make the sunlight less intensive.

You can also change the default yellow color to white, for
example.

properties of the sunlight. Go to Edit
Material to change properties.

To edit the position of the sunlight, go to Edit position. Drag
the yellow circle with left mouse button to adjust the light
in the room.

Check the result in preview.

The background image in the window can be also changed.
Go to Window > Background Image and find the one that
you like.

SaintLazarusChurch
SaintLazarusChurch3
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Press RMB on a tile, go to Edit material to open the table of advanced settings.

Main settings used:

Albedo - albedo color changes the color of the tile

Ambient - ambient level changes the brightness of tiles.

Lower value - darker tile.

Directional - diffuse level regulates the brightness of tiles
(the higher the value - the brighter the tile is)

Reflection - By increasing reflection level, you can increase the reflective ability of the tile

Reflection roughness - makes the image of the tile clearer
(higher the value - more blurry the image gets)

Glare level - stands for the size of the light circle in the tile.
(the higher the walue - the bigger the circle is)

You can increase the value of glare roughness to make the light circle even more blurry.

Multimaterial Fender
Albedo Ambient |Bump Directional Emission
Albedo
Albedo color - F Mpedolevel[7
Ambient
T Ambient color =7 Amtient level [0.72
| Directional
| Diffuse color = s Difiise level [072
Emission
Emission color -l #  Emissionlevel I
Other
| Reflective yes | no Refractive yes | no
| Smooth reflections yes | no Smooth refractions yes | no
Reflection
Reflection color =|#  Reflectionlevel [03
_| Glare sarameters [ Glare color EV4
Refraction
Opscity [T Refraction color | Va
Thin_film
FnmECRE | mnmemampP |
Voxels
Ambient color -l & Diffuse color | V4

Diffuse level [0.75

Emission color g =g
PER
l‘— emission [
specuar [T specular color =&
G | thin fimthickness [p
.

Diffuse roughness [T

Add Map. Save as.

| Other Reflection

Mo BIEE X My v R
Mapshiﬁbyuivln_lu_

Map rotation [§ .
Distance of Curve shape of
ambient cccheion [1 ambsent ociteion [15
Difiuse roughness [0 me: 0
Light source
~[» -
Light source yes | no Agenuation [0
ey [0.001 Glarelevel [§
Refraction level [ Refraction index [7
Prsnbrst
Reflection color ~ 7 Opacity [1
Reflectionlevel [0 m’ﬁ;‘: 10
emissioncolor | ~ V2 metalness [0
roughness [02 specuarior [15
thin filmior [15

Refraction Thin_fim Woxels

Load from.

Apph o set

|PBR

!
\Wirapping of texture coordinates
U [repeat -
v |repeat -
£ Bump ]
| ampker 3015 X
f
A
L]
!
Glare roughress [7 e -1
a
Reh
roughasss [0
f
A
Back level Ju]— Ambient level [0 75
Reflection index ’1— Emission level ln—
!
base [0.8 base colot ~| V
O itance color =7
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You can add 3D model individually if needed. Make
sure, that the model you want to add is .obj format.
It is better to export the model to test folder:
C:\Ceramic3D\Lib\Objects\Test

Launch Ceramic3D, create an empty room, e. g.
4000x4000x3000 mm.

Select front view (F10), ALWAYS place the object to
it before saving it to the library.

Select the wall, update the library, and find the not-
ready model.

Press and hold SHIFT and select the chair and the
wall

Press to "Alignment” in the appeared window,
select: X by left edge,

Y by bottom edge (only for objects standing on the
floor),

Z by far edge.

Click RMB, go to Properties, and reattach

the materials to the ones from the library.

If the model contains some reference number,

type it in the insert field in the bottom of Properties
window.

Initial installation of the cbject X Save the object
[¢ Can stand on the wall
Distance from the wall |0 mm
Distance from floor to bottom clearance 0

Distance from the floor to the top clearance
Distance from ceiling to upper clearance
Arbitraty position on the wall

i

[~ Can stand on the ceiling

Object Alignment
Align objects on X-axis direction ==+
.
by left edge

"
by center

by ight edge

Align objects on Y-axis direction ==+
by top edge

= by center
by bottom edge

Align objects on Z-axis direction ==+
by far edge
by center
by near edge

1700
| the work easier.
[v Can stand on the floor
Distance from the floor |0 mm
Seectiog (lamp, chandelier).

1 ohjects

Position
Absolute position

Angles
Show
Always hidden

Automatic alignment

Object type
Affects the environment

Sizes

Assigned materials:

Saving to file

Auto hiding
Influence by dimensions

z:0 ¥ Rela'

7:|-504 I~ Rela

R:|-180

I~ Rela

Clear out

Apply orientation

Optimize object

Recover sizes

Create a box out of grid |

+ |

-+

'
W

Fabric flowers | ¥ |~

‘ |° Dark gray plasi * |~

+

Save... |

=
r

Invert faces
Angle of smoothing |30 Apply |

Auto smoothing

Reflection X | Y I z |
Show position in report 2

Show as door hole in report |~

Item Code [scadis92s

Ok |

Cancel |

There appears a window with settings.

Objects - Save to file - Object, select the Test folder, press Save.

Fixed incline - use this option if the object should have the same
orientation when installed on floor, wall or ceiling.

Can stand on the wall - the object can be installed to the wall
(e. g. wall drawer). There are also settings of distance, which can make

Can stand on the ceiling - the object can be installed to the ceiling

Can stand on the floor - the object can be installed to the floor
(e. g. cabinet, table).

Press OK to save the model. Update the library of objects and the
image (Right mouse button> Update image). The model is ready to use.
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To add a material (texture of wood, fabric etc.)
to the library, you firstly need to find the image
of that (.jpg). Make sure, that the texture is
seamless (without any white outline).

To add a texture press RMB on a plane or an
object. Go to Properties.

Choose a suitable group of materials and apply
any basic material to it (Jasmine for grouts,
White Plastic for paint, Walnut for wood etc.).
Press “->" to edit properties. Click to “...." Near
the Texture field and upload the image you
found.

EE;

CAC3DENG\Lib\Materials\Plastics\Dark gray plastic.cm

Vertex Ipixd |

ot -

o R

et |
stiiness 125

Texture _I r
Blend Mode  [Replacement +

b (|sh— J
o ot 1 o
P o |

-
% Cut Ctrl+X
Copy Ctrl+C
Hide Selected Ctrl+H

Show All Shift+Ctrl+H

Make the room active

Select Always Hidden Objects

<+ Move M
(j Rotate R

o Scale 5

Grouping 4
Editing >
W Delete Del

Edit Material Copy
Edit Matenal
Add material for selection in VR...

A 1 objects
|Grey Sofe|

[Position X0 v:|o zjp ¥ Rela
|Absolute position X:[859 ¥:|-4153 2:|-904 [~ Rela
Angles pi-180 o rif-180 I Rela
Ishow v
|Abways hidden r
(Automatic slignment Enzble
Object type 1 Choose... Clear out
\Affects the environment r
wi[1748 1 :
iSizes H:[872 | [ Relw
Difor4 1!
Center
Apply orientation
Optimize object
Recover sizes
Create a box out of grid
=>|
Q@3
|Assigned materials: -
i ->|
O Fabric flowers| ¥ z{ ‘
Saving to fie Save...
(Austo hiding r
Influence by dimensions (™
Invert faces
|Auto smoothing Angle of smoothing |30 Apply
Reflection X|v|z
iShow position inreport | |¥
iShow as door hole in report] ||~
tem Code 403018925
x| Cancel
v




OTHER MATERIALS

The texture in Vertex section is ready, repeat the action for the section Pixel.

The texture is successfully added.

If you want to save the created texture to the library of materials, go to the 3D mode.

Make the right click to the desired texture, then go to Edit Material. Press to Save as and save it to the
Materials folder.

Material Editor u
Multimaterial Fendsr AddMap. Savess Losd fiom Apply to set
Abeda Ambient Bume Directional | Emission Other Feflection || Refiaction || Thin_fim Vanels PER
Albedo 2
Albedo color =V Albedo level [ Abedomap  EVES X MPRe v @ Virapping of texture coordinates
Mapshiftby U/ V[0 0 U: [repeat -
Map rotation ’ui c V: [repeat :I'
Ambient A Bump ]
Distance of Curve sl of Percent of ambient =
Ambient color =l e Ambient level [p,72 ambient ccclusion |1 ambient ooc.‘laups?on 05 occlusion |1 Bump Map DEX
Directional ]
Diffuse color B4 Difiuse level [0.72 Difiseroughoess [ L“’l;';h‘"‘n;: I
Emission ]
Emission color ~ v g Emission level [p . Light source
~]» +
Other P
Reflective yes | no Refractive yes | no Light source  yes | no Agtenuation [0
Smooth reflections  yes | no Smooth refractions  yes | no
Reflection ®
Refection color | #  Rellectionlerel [15 o o5 Glarelevel [§ Glare roughness [ petecior L=
Glare parameters -j Glare color =
Refraction ]
Opacity [7 Refraction color <] #  Reincionlevel [§ Refraction index [] ,Rn‘:;‘:"ngg o
Thin_film ®
Film refractive Mirimum fim M il
index [1.5 thickness in nm [0 thickneaa in nm |0
Voxels L]
Ambient color ~ A Diffuse color Llﬁ Reflection color - Va Opacity [1 Back level [01 Ambient level [775

Diffuse level [0.75 Difiuse roughness [g Reflectionlevel [0 m 10 Reflection index [1 Emission level [§
Emission calor B ===

PER ]
opacity [T emission [0 emission color - F metalness [7 base[0s base color - #
specuae [T specularcolor Bl roughress [17 specularior [{5 CE— I =4

) | thin film thickness [ thin flmior [1.5
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